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Application Shell - Overview
The application shell is used together with the frame gallery for developing, administering, and monitoring
application solutions. They provide an infrastructure in which numerous standards are defined and are
implemented in the form of reuseable components, such as dialogs and procedures. 

With the help of the frame gallery, both simple and complex applications can be implemented more quickly and
maintained more easily than with traditional methods. In addition, the reusability of individual components
results in considerable gains in quality and productivity. 

The application shell provides application administration facilities for both the application developer and  the
application administrator. 

Applications created with the application shell use the standard administration functions described in this
documentation. If there are customer-specific administration functions or procedures to be observed, this
documentation should be supplemented by an application-specific document.

Navigating in the Application Shell 

Functional Scope 

Administration Milestones 

Object Maintenance 

The Translation Subdialog 

The authors of the Application Shell documentation assume that you have a working knowledge of Microsoft
Windows and the terminology used to describe it. If not, consult the Windows documentation for a description of
basic Windows elements, usage and terminology. 

Platform-Specific Information

Wherever necessary, platform-specific information in the present documentation is identified by the following 
terms:

Mainframe Refers to the operating systems OS/390, VSE/ESA, VM/CMS and BS2000/OSD, as well as all
TP monitors supported by Natural under these operating systems. 

OpenVMS Refers to the OpenVMS operating system. 

UNIX Refers to all UNIX systems supported by Natural. 

Windows Refers to the following operating systems:

In a Natural development environment:

Microsoft Windows NT 
Microsoft Windows 2000 

In a Natural run-time environment:

Microsoft Windows 98 
Microsoft Windows NT 
Microsoft Windows 2000 

OS/400 Refers to the OS/400 operating system running on AS/400 and iSeries 400 machines. See the
documentation provided on the Natural for OS/400 product CD-ROM. 
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Navigating in the Application Shell
The following topics are covered below:

Starting the Application 
Using Navigation Icons 
Starting a Function 
Using a Function 
The Browse Function 
The Mass Processing Function 
Closing a Function 
Closing an Application 
Resuming an Abnormally Terminated Session 

Starting the Application
 To start an application from the Natural development environment

Select the tool bar button which represents the application shell. 

Using Navigation Icons
When you start an application, the window that serves as the background for your application is opened.
Additionally, if the corresponding setting is placed in the profile user exit, a dialog is opened which contains all
available navigation icons that correspond to this level in the application. 

Navigation icons can be used to navigate through the hierarchy of the application. There are three possible types
of navigation icons: sub-application, object type and function. Below each icon is a name which differentiates
the icon from the other icons. 

The Navigation Icons 
Choosing a Navigation Icon 
Navigating with Icons in a Sub-application 

The Navigation Icons

Sub-application

A low-level application which lies beneath a top-level application, or another sub-application. 

When you select a sub-application icon, all the functions and objects that are hierarchically one level below the
sub-application are displayed. See Navigating with Icons in a Sub-application. 

Object Type
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Contains the objects defined for this object type (e.g. customers, contracts). 

When you select an object type icon, a browse dialog is displayed which lists the objects available for the
corresponding object type: for example, all contracts. 

Function

You select a function icon (e.g. Maintain Customer, Maintain Distributors) to maintain a specific object. When
you select a function icon, a key-ID dialog is displayed. In this dialog, you can enter an ID and, as a result, a new
dialog displays the data available for the corresponding object. For example, customer data, such as: name,
address, birthday. 

Choosing a Navigation Icon

All navigation icons, regardless of their level in the hierarchy, can be chosen using several different methods. 

 To choose a navigation icon

Double-click the icon.
Or select the icon and press ENTER.
Or select the icon from the tool bar, and choose the Open button.
Or select the icon from the Object menu, and choose Open. 

Navigating with Icons in a Sub-application

The hierarchy of an application can be divided into as many as 20 levels. For example, the sub-application 
Yacht-Crew-Exchange may be divided into the sub-applications Cruise Maintenance, Create Catalog, and 
Customer Maintenance. Cruise Maintenance may be further divided into the sub-applications Scheduling, 
Skipper Maintenance, Yacht Maintenance and Customer Booking. 

 To navigate down the hierarchy

From the entry-level window, choose a sub-application icon.
When you choose a sub-application icon, a new window is opened displaying the icons on the next level.
You can continue to move down in the hierarchy in this manner. When no other sub-application icons are
displayed, you have reached the lowest level in the branch of the hierarchy you followed. 
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 To move to the entry level

From the Select menu, choose Entry Level.
Or click the following toolbar button:

Using either method results in returning to the entry level in the hierarchy. 

 To move to the previous level

From the Select menu, choose Previous Level.
Or click the following toolbar button:

Using either method results in moving one level back in the hierarchy. 
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Starting a Function
You can start a function with one of the following methods. 

Starting a Function by Choosing a Function Icon 
Starting a Function by Using the Browse Function 
Starting a Function by Using a Direct Call 

 To start a function

Choose a function icon in the navigation window. 
Or select an object using the Browse function and from the Object menu, choose the action (e.g. the Add or
Modify command) you want to perform.
Or with a direct call, select an object type and choose the action. 

Starting a Function by Choosing a Function Icon

You choose a function icon (e.g. Maintain Customer, Maintain Distributors) to maintain a specific object. When
you choose a function icon a key ID dialog is displayed. From this dialog you can enter an ID and, as a result, a
new dialog displays the data available for the corresponding object. For example, customer data, such as: name,
address, birthday. 

Starting a Function by Using the Browse Function

When you select an object via the Browse function, you can start a function with one of the following methods. 

 To start a function with an object 

From the Object menu, choose the action (e.g. the Display or Add command) you want to perform.
Or choose the action represented by a tool bar button.
Or double-click the object in the list box.
Or choose the command button for the action you want in the browse dialog. (This option is dependent on
the dialog design for your browse function.)
As a result, a main dialog appears in which you can perform the action. 

5Copyright © Software AG 2002

Starting a FunctionNavigating in the Application Shell



Starting a Function by Using a Direct Call

When you are familiar with the structure of the application, you can, as an alternative to using the navigation
icons, start your functions with a direct call. 

 To start a function with a direct call

1.  From the Select menu, choose Direct Call.
Or click the following toolbar button:

As a result, a dialog is displayed consisting of two combo boxes. The first combo box lists all object types
defined to the application, while the second combo box is empty. When you select an object type from the
first combo box, the applicable actions (e.g. Add, Display, Delete) for the object are displayed in the second
combo box. 

2.  Select the object type.
Or enter the name of the object type in the corresponding text box.
In both cases, the applicable actions that can be performed with the object type are displayed in the second
combo box. 

3.  Select the action you want and choose the Start command button.
Or if you do not want to start an action, choose the Close command button. 
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Using a Function
The following topics are covered below: 

Dialog Organization 
Command Buttons in the Dialogs 

Dialog Organization

This is an example of the first dialog to appear, once you have chosen the object you want to administer. 

The processing of a function can consist of more than one dialog, especially when all of the data for the object to
be administered does not fit in the main dialog. 

The data for the object which do not fit in the main dialog are grouped together according to topics (e.g.
background processes, programs) and can be displayed in subdialogs. 

From a main dialog, you can display a subdialog using one of the following methods.

 To display a subdialog

Choose the topic (e.g. salary, vacation) from the View menu.
Or choose a command button (indicated by three periods following the topic, e.g. Salary...) from the main
dialog. 
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Command Buttons in the Dialogs

The following standard command buttons are available in the various levels of the dialogs. 

Main Dialog

Close Closes the active main dialog. If a subdialog is also open, it too is closed. If you choose this button
before you save your modifications, a message box appears in which you must choose either to save
your modifications, or not. The main dialog is not closed until then. 

Confirm Verifies and saves the modifications in a preliminary file. The main dialog is not closed as a result of
this button. When you later choose the Close button, the modifications are applied to the database
and the modifications in the preliminary file are deleted. 

Subdialog - First Level

OK Verifies and saves your modifications in a preliminary file and closes the subdialog. 

Cancel Closes the subdialog without saving the modifications. Before the window is closed, a message box
appears where you are required to confirm the Cancel command. 

Confirm Verifies and saves the modifications in a preliminary file. The subdialog is not automatically closed. 

Refresh Undoes modifications previously made. Choose this button when you have made modifications and
then decide if you want to return the object to its previous state. If you have already confirmed your
modifications, you cannot select this button. 

Help Displays information that pertains to the function you are currently performing. 

Subdialog - Second Level

OK Verifies and saves the modifications in a preliminary file. As a result, the subdialog is closed. 

Close Closes the active subdialog. If you modified data in the dialog and choose this button, a message box
appears and you must choose to either save your modifications, or not. 
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Tool Bar Buttons and Menu Commands

The following are usually available as tool bar buttons while performing a function. Depending upon your
security status, some of the buttons may not be available in the tool bar.

If the action you want to perform is temporarily not available, a diagonal line appears through the arrow pointer
when positioned over the corresponding button. 

 To create a new object

From the Object menu choose New.
Or click the following toolbar button:

 To open an existing object

From the Object menu choose Open.
Or click the following toolbar button:

As a result, a key-input dialog appears in which you select the object you want and choose the OK button.
The resulting new dialog contains the data for that object. The previous dialog remains open, directly
behind the new dialog. 

 To read another object

From the Object menu choose Read.
Or click the following toolbar button:

As a result, a key-input dialog appears in which you select the object you want and choose the OK button.
The resulting new data is displayed in the current dialog. Unlike the Open an Existing Object button, a new
dialog does not appear. 

 To display an object

From the Object menu choose Display.
Or click the following toolbar button:

 . 
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 To modify an object

From the Object menu choose Modify.
If you are in display mode (with the Display object button), you can select this button to change to modify 
mode.
Or click the following toolbar button:

 To delete an object

From the Object menu choose Delete.
Or click the following toolbar button:

 To refresh to previous status

From the Edit menu choose Refresh.
Or click the following toolbar button:

As a result, the object is returned to the state of the last confirm. 

 To terminate processing

From the Object menu choose Close.
Or click the following toolbar button:

As a result, the dialog is closed. If you choose this button before you save your modifications, a message
box appears and you must choose to either save your modifications, or not. 

 To save an object

From the Object menu choose Save.
Or click the following toolbar button:

As a result, your modifications are saved and the object is updated so that it is again available to all users.
The active dialog is not closed. 

 To save an object under another name

From the Object menu choose Save As.
Or click the following toolbar button:

A key-ID dialog appears, in which you must enter a new ID. The object is then saved under this new ID and
control is returned to the dialog which contains the new object. 
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The Browse Function
When you want to work with an object, but do not know the object’s ID, you can browse through a list of objects
to select the object you want. 

 To use the browse function

1.  Choose the appropriate object-type icon. 
As a result, a browse dialog appears. A browse dialog contains a list box, which lists the objects available
for the object type icon and, one or more text boxes, in which you can enter selection criteria (e.g. client ID
and object type ID). The selection criteria enables you to filter out unwanted objects.

2.  Enter the selection criteria in the text boxes and choose the Search command button.
As a result, the objects which meet the requirements are displayed at the top of the list box. Once you have
obtained the object you want, you are ready to start a function. 

The Mass Processing Function
Another type of function is the so-called Mass Processing function. You use this function when you want to
work with several objects of the same type. 

The Mass Processing function is beneficial when, for example, you want to modify several objects. Instead of
selecting the objects individually and opening a dialog for each object, you can select the objects together and
then choose the Mass Processing function, which results in only one dialog. You page through the selected
objects from this window. 

 To use the Mass Processing function

1.  Choose the object type icon you want. 
2.  Choose the objects you want from the browse dialog. 
3.  Choose Mass Processing from the Object menu.

Or select the Mass Processing tool bar button.

Note: 
If the Mass Processing command is not available in the Object menu, either the Mass Processing function is not
available for this object type in your application, or you are not permitted to use this function. If one of these
cases occur, see your administrator.
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Closing a Function
There are several different ways to close a function. 

 To close a function

Choose the Close command button in the dialog.
Or choose Close from the Control menu.
Or double-click the Control-menu box.
Or press CTRL+F4.
If you have not saved your modifications, a message box appears and you must either choose to save or
delete the modifications. 

Closing an Application
You can close an application using one of the following methods. 

 To close an application

From the Object menu, choose Close Application.
Or choose Close from the Control menu of the application window.
Or double-click the Control-menu box of the application window.
Or press ALT+F4. 

Resuming an Abnormally Terminated Session
As soon as you begin processing the data of an object, a temporary reference is created and is later deleted with
the normal end of that transaction. However, if during active processing, the application is abnormally
terminated, the temporary reference is not deleted. 

When you restart the application, a message box appears and you are asked to confirm that the new session is a
parallel session. 

If you choose the Yes button, a new session, parallel to the previous session, is begun and the temporary
reference is not deleted. 

If you choose the No button, the temporary reference is deleted and a new session is begun. 

If you choose the Cancel button, the session is terminated without deleting the temporary reference and control is
returned to your Natural environment.
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Functional Scope
The following topics are covered below:

Command System 
Authorization System 
Table System 
Help System 
Production Monitoring 
End-User Support 
Save Object As Dialog 
Selection Dialog 

Command System
During the development of an application, the command system is used to carry out the following tasks:

Defining applications and sub-applications, assigning object types and functions, 
Defining commands, 
Maintaining object types and functions, 
Defining tool-bar buttons, assigning commands and bitmaps, 
Assigning tool-bar buttons to the various dialog types. 

When the system is in production, the following objects can be maintained using the command system:

Application 
Dialog type 
Function 
Object type 
Command 
Tool-bar buttons 
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Authorization System
The authorization system is used for the following tasks:

Defining users to the system, 
Grouping functions, 
Linking function groups with users. 

Thus, which user is authorized to execute which functions can be easily defined. 

Specific authorizations are usually made by the application administrator at the time the application is put into
production. 

The following information object types are administered with the authorization system:

User 
Function 
Function group 

Table System
The application shell can be used to create and maintain simple information objects called tables. 

Tables can be quickly defined and the necessary administration functions are available immediately to accept
and maintain the corresponding data. 

The tables are usually defined by the developer, but data can be supplied by the end user who will later also be
responsible for maintaining it. 

The following object type Table is administered with the table administration system: 

Help System
The help system administers help texts that are to be displayed to the end user on request and independent of
context. 

The help text is usually created and maintained directly by the end user responsible for a particular business area. 

The application-shell help system is based upon Windows help. For further information, see the Windows
documentation. 
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Production Monitoring
The application-administration system can be used to monitor applications which are in production so that
appropriate corrective actions can be undertaken whenever necessary. 

The following functions are provided:

Display locked data 
Maintain error log 
Maintain load log 
Maintain preliminary file 

End-User Support
Some functions are useful to all end users. These include functions are, for example:

Maintain error log 
Maintain load log 

Save Object As Dialog
The "Save object as" dialog appears each time you add a new object type. Depending upon the object type, the
title of the second text box and the list box change to reflect the current object type (e.g. Command ID and
Command, Application ID and Application). 

1.  In the Client ID drop-down combo box, select the client for which this object will be used.
The client delimits the information available with this object. For example, if you select client XJ, this
object type will be used only for client XJ. 

2.  In the User ID text box, enter an ID which uniquely identifies this object.
This is the same ID that you can specify with the browse function. The User List box displays the object
IDs which are already defined for the client. 

3.  Choose the OK button.
A message box appears which informs you that the object was successfully saved. 

4.  Choose the OK button. 
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Selection Dialog
The Selection dialog appears whenever a function is modified, displayed or deleted. The title of the second text
box and the list box change to reflect whether you are maintaining the object-type ID or a command of the 
function.

1.  In the Object type ID text box, enter the ID of the object type.
Or choose the object-type ID from the Object type list box.
The object-type ID determines which object this function acts upon. 

2.  Choose the OK button. 
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Administration Milestones
The administration system is used to to administer projects consisting of modules generated on the basis of the
frame-gallery dialog frames. The administration system is used to integrate functions into the existing dialog
management, assign bitmaps and tool bars, define tables which can be addressed from the functions. 

The application-shell administration system supports primarily the development of specialized applications. The
administration system can also be used, however, when the specialized application is already in production. So,
for example, background processes can be monitored, application structures can be defined, access protection
can be implemented on specialized functions, and activities within the application can be monitored. 

The following topics are covered below: 

Creating Applications 
Defining Commands 
Integrating Functions 
Issuing Authorizations 
Processing Help Texts 
Processing Tables 
Background Processing 
Loading and Unloading Data 
Monitoring at Runtime 

Creating Applications
To integrate an application into an existing system, various actions should be completed before the development
work on the new application can begin. 

These actions are also necessary when an application is transferred from the development environment to the test
environment or from there to a production environment. 

Adding Languages

If an application is required in several languages, you should first check whether all necessary languages are
defined in the application-shell. 

The following languages are initially available: 

English 
German 

The application-shell administration interface, including the necessary Natural dialogs, error texts, help texts and
commands already exist in English and German. 

If you require the administration system in another language, you can add a new language as explained below.
The language you add should also be supported by Natural. 

 To add a language

1.  Translate dialogs and error messages into the target language. 
2.  Translate the name and DIL text for applications, background procedures, commands, functions, function

groups, languages (name only), and object types into the target language. To do so, complete the following 
steps:
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Choose the corresponding bitmap. 
Choose the object from the list box in the resulting dialog, and choose the Modify Object button. 
Choose the Translate button from the resulting dialog. 

3.  In the resulting dialog, choose the language you want to translate to. 
4.  In the lower group box, enter the translation for the name and, if necessary, the DIL text. 

Defining an Application

With the help of the application-shell administration system, you can administer several applications in various
Natural libraries in parallel. 

When a new project is begun, the programs that belong to this project are usually kept in a separate Natural
library. Since the functions defined in the application-shell that call these modules are independent of the
application, the appropriate functions should be accessible to the new application. This means that the functions
should be added to the new application. 

 To define a new application

1.  Choose the Application bitmap. 
2.  Choose the Add a New Object button from the Browse Applications dialog. 
3.  Define the following in the Maintain Application dialog: Name, DIL Text, Bitmap, Application Type,

Library (not required for sub-applications). 
4.  Define the following in the "Save object as" dialog: Client, Application ID. 

Defining Users

Users who require access to an application should be defined in the authorization system. 

Note: 
If your application does not use access security, you need not define users.

When other applications are already running with the same application-shell core, first check whether the users
are already defined in the application-shell. For this, you can use the Browse function. See the Natural Frame
Gallery documentationl. 

 To define a new user

1.  Choose the User bitmap. 
2.  Choose the Add a New Object button.from the Browse Users dialog. 
3.  Define the following in the Maintain User dialog: Name, Allowed or disallowed functions. 
4.  Define the following in the "Save object as" dialog: Client, User ID.

Authorization is checked through the User ID under which the user is added to the system. The user’s name
is purely for information. 

Defining Commands
Application-shell dialog management works on the basis of command buttons, menu commands and tool-bar
buttons. All these alternatives serve to start a particular function. 

To start a function, that is, an independent function that consists of a combination of several dialogs, you should
specify a command and an object type on which the command is used. For example New (command) customer
(object). 
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All commands can be defined in several languages and can be modified even when the system is in production. 

Before you define a new command, first review the existing commands to determine whether one of the current
commands can be used. 

You thus avoid defining unnecessary commands and decrease the amount of maintenance effort. 

Defining Commands

Reviewing Existing Local Commands

You can review the commands that are already defined by using the Browse function. 

Adding New Commands

 To define a new command

1.  Choose the Command bitmap. 
2.  Choose the Add a New Object button from the Browse Commands dialog. 
3.  Define the following in the Maintain Command dialog: Name, DIL, Bitmap, Main type. 
4.  Define the following in the "Save object as" dialog: Client, Command ID. 

Renaming Commands

You can rename the commands at any time. So, for example, New can be renamed to Add. Renaming should be
performed only when absolutely necessary. If you rename a command, take care to ensure that all affected users
are informed. 
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Integrating Functions
A function generated with a frame gallery frame should be integrated for execution in the dialog supplied by the
application-shell. After the necessary commands have been defined, this integration can take place. 

The integration procedure consists of defining object types and functions and modifying the structure of the
application. 

Defining Object Types

Reviewing Existing Object Types

You can review the existing object types with the Browse function. 

Adding New Object Types

 To define a new object type

1.  Choose the Object Type bitmap. 
2.  From the Browse Object Types dialog, choose the Create a New Object button. 
3.  Define the following in the Maintain Objects dialog: Name, DIL, Bitmap ,Dialog ID (optional - this is the

ID for the Browse dialog).
Be sure to use easily recognizable object names. 

4.  Define the following in the "Save object as" dialog: Client, Object type ID. 

Example: Customer, Invoice, Article

Defining Functions

Reviewing Existing Functions

You can review the existing functions with the Browse function.

Adding New Functions

  To define a new function

1.  Choose the Function bitmap. 
2.  Choose the Add a New Function button from the Browse Functions dialog. 
3.  Define the following in the Maintain Function dialog: Name, DIL, object-type ID (should be identical to

that specified as the corresponding object’s object-type ID), dialog ID (identifies the dialog or subprogram
for this function), Type (usually dialog, however, the Delete function is always a subprogram), Bitmap,
Commands (e.g. New, Display, Modify). 

4.  Define the following in the "Save object as" dialog: Client, Function ID. 
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Defining an Application Structure

Many end users prefer to navigate through dialogs rather than by using commands. This is especially true for a
new application. 

A dialog structure should be constructed so that each function can be reached from the main application through
several sub-applications. 

You set up the application structure after you have defined the application and the required functions and object
types. Once these are defined, you can then modify the application and define the structure in the Assign dialog. 

Reviewing Existing Functions

You can review the existing applications with the Browse function. 

Modifying Applications

 To modify an application

1.  Choose the Application bitmap. 
2.  Choose the Modify an Application button from the Browse Applications dialog. 
3.  Define the following in the Maintain Application dialog: 

Choose the Assign button.
In the Assign dialog, define the following: Type (determines the processes the application can start, e.g.
start a browse, start a function),
Available (determines which applications, functions and object types are available with this application). 
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Issuing Authorizations
The first step in developing access authorization is to determine whether the application will be accessible to all
users or access will be protected.

If you decide to enable access protection, then the next stage is to define the users and the access each user will
have in the application. 

If you decide that access protection is not required, you need not define users. 

The final stage is to define access protection for the specific functions. It is through the function groups that the
authorized user is defined for the individual functions. 

Application Protection

Once an application has been developed, you should decide which functions will be access protected. 

Access security is defined in the user exit ZXUSEC0N.

Access protection for an application has priority over all functions. For example, the functions of an application
with access protection are also initially access protected from all users. On the other hand, the functions of an
application without access protection are initially accessible to all users. 

Defining Function Groups

The function group is the link from a user to a function. 

For each function group, access-protected functions are marked as allowed or disallowed. Specific users are then
assigned to the function groups. So, for example, the administrator can allow the members of the Contracts
function group access to a function, but disallow access to the same function to the members of the Customer
Service function group. 

To define function groups, choose the Function Group bitmap. 

Protecting Functions

For each function, you should decide whether access protection will be applied. 

If you do not implement access protection for a function, each user that is allowed access to the application is
also permitted to use the function. 

If, however, you do implement access protection for a function, only selected users can access this function
(which is defined as allowed in at least one function group). 

Depending upon whether or not the application is access protected, the following hierarchy for access protection
is applied to each user. 

Application with Access Protection

all functions are disallowed 
except for the functions defined as allowed in the function groups 
except again for the functions defined as disallowed in the function groups 

Application without Access Protection
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all functions are allowed 
except for the functions defined as disallowed in the function groups 
except again for the functions defined as allowed in the function groups 

Complete functions can be access protected. Subdialogs, however, cannot be explicitly access protected. 

 To integrate a function into the authorization system

1.  From the Maintain Function dialog, select the Access Security check box in the Setup group box. 
2.  Choose the Function bitmap. 
3.  Add a function group if it does not already exist.

Choose the Function Group bitmap. 
4.  Integrate the function in the function group.

Choose the Function Group bitmap.
When the application is access protected, each function should be marked as allowed.
When the application is not access protected, each function should be marked as disallowed. 

5.  Assign the users who are permitted to execute the function to the function group.
Choose the User bitmap.
The next time the user starts the application or chooses Refresh Initialized Data from the Options menu, the
defined access authorization will be applied. 

Processing Help Texts
The application-shell uses Microsoft’s Help Compiler to process the help text. Please refer to the corresponding
Microsoft documentation for more information. 

Processing Tables
The application-shell table-maintenance function is used to build information objects on which only maintenance
functions are to be carried out. Typical examples are country tables and currency tables. The table system avoids
generating a file and creating all the necessary maintenance functions. 

Deriving Tables

If an information object requires no more than fifty input fields and four descriptors and only the actions listed
below are required to process the information object, the information object can be defined in the form of a table. 

Browse 
Delete 
Display 
Modify 
New 
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Using tables offers the following advantages: 

The effort in database design is reduced. 
The creation of a file is not required. 
The development of the processing functions is not required, since they are automatically generated when a
new table is added. This includes the necessary subfunctions for language translation. 

Additional processing for this type of information object is not required. The implementation is limited to the
definition of a table in the application-shell table maintenance system. 

Defining and Using Tables

Once you have defined a table (with the function New Table), you can then begin processing the table data using
the dialog functions generated in the system for processing table data. No intermediate steps are required. 

When special functions are in development, table data can be accessed using a standard access module. For
information on this procedure, see the Natural Frame Gallery documentation.

Maintaining Table Contents

Tables should be maintained by a defined group of people. Your task as the administrator is particularly
important when the tables are used for system control. Status tables and parameter tables should be withdrawn
from general access to ensure that unauthorized modifications cannot be applied. 

Modifications to table values can in some instances have far-reaching consequences which, at the time of
modification, may not be apparent. The maintenance of such sensitive tables should therefore have access
protection. 

Defining Access Protection for Tables

When you define a table, the required maintenance functions are automatically generated. 

Functional access protection for functions that maintain tables can be defined analogously to authorization for
other functions. 

Renaming Tables

You treat a table in the application-shell just like any other object type, however, when you rename a table you
use the function Modify Table. Thereby a difference between table definition (administration maintenance) and
table contents (user maintenance) is guaranteed. 

Renaming a table requires the same care as when you rename a command. 
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Special Handling of Table Contents

The table maintenance system itself carries out standard validations, such as checking required fields. If you
require additional validation, or if, when entering data, particular formats should be observed, a user program
that performs these activities should be allocated. 

You define the user program when you add the table. 

For further information, see the Natural Frame Gallery documentation. 

Background Processing

General

Frequently, functions that require high-volume access to the database are implemented as background processes
so as not to delay processing. 

The application-shell provides facilities for monitoring background processes. 

Creating a Background Procedure

The necessary background procedure for the operating system can be written in the application-shell with the
command New Background Procedure. Input, such as the name of a printer or the name of a necessary workfile,
can be added to the procedure as parameters. 

Starting a Background Process

Background processes that are to be monitored with the administration system should be created with the
program frame ZXFBA00C. 

The background process is usually started from an online function. 

For further information, see the Natural Frame Gallery documentation. 

Displaying the Status of a Background Process

You can use the command Browse Background Processes to display the current status (process in waiting queue,
or process terminated due to error) of the background processes that are sent from an application that uses the
current application-shell core. 

Error Handling

If a background process is terminated due to an error, detailed information for that error can be displayed with
the function Browse Background Processes or Modify Error Log. Recommendations on error corrections can
also be entered here. 
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Loading and Unloading Data

General

Loading and unloading data may be necessary for various reasons: migration, porting into another environment,
archiving data, etc. 

Creating Load and Unload Modules

For application-shell object types that already exist, you need not create load and unload modules. However, for
specialized object types, these modules should be created. The procedure for creating these modules is added as
a background procedure. For further information, see the Natural Frame Gallery documentation. 

Allocating Loading and Unloading Modules

To load or unload data in an orderly manner, you should assign the names of the background program and
background procedure that are required for execution. You assign the background program and procedure with
the function New or Modify Object Type in the Procedure subdialog. 

Selecting Data

You use the function Load Object Type or Unload Object Type to select the data to be loaded or unloaded. 

Unloading

The unload procedure is used for archiving data, for migrating from one application shell version to the next or
for porting data from one environment to another. 

The unload job, a background process, is started with the function Unload Object Type. You also define where
the data should be unloaded to. 

You can observe the activities of the background process with the function Display Load Log. 

Loading

The load sequence should be proceeded by an unload sequence. Either archived data or data that was unloaded
for the purpose of migration can be loaded. 

The load sequence is also a background process. You start the background process with the online function Load
Object Type and specify where the data is to be loaded. 

You can observe the activities of the background process with the functions Browse Load Logs and Display
Load Log. 
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Monitoring at Runtime
During development and when the finished application goes into production, you need particular tools to monitor
processing and to access running transactions to correct error situations. 

The activities described below are available to all developers during the development of an application. 

Processing Errors

The errors that occur in a background process are always logged. 

You can use the function Maintain Error Log to display the errors that have occurred and to enter
recommendations on how to correct the errors. 

Checking Locks

As a rule, all data records are logically locked while they are being processed. You can use the function Browse
Locks to display the data records that are currently logically locked. 

Maintaining Temporary Data

You can transfer data from one dialog to another using either the global data area or a preliminary file. You can
use the functions Browse Preliminary File and Delete Preliminary File to display an overview of the contents of
the current file which contains the provisional copy of the data records currently being processed. The entries
that have no references to transactions or locks can be removed. 
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Object Maintenance
The application-shell defines an object type (or, more precisely, a dialog object) as a coherent set of business
data that can be maintained together. For example, the following data elements could be combined to form the
object type Customer: Customer number, Customer name, Street, Zip code and City. The name of the object type
is used as a component of a command for dialog management. 

The following topics are covered below: 

Application 
Background Procedure 
Background Process 
Command 
Dialog Type 
Error Log 
Function 
Function Group 
Initialized Data 
Languages 
Load Log 
Locks 
Object Type 
Preliminary File 
Table 
Tool Bar 
User 

Application
Some application-shell objects can be defined for a specific application. To keep these objects independent of the
Natural library name, applications must be maintained through the library names which are linked with internal
codes. 

Function Overview

Actions

Browse 
Delete 
Display 
Modify 
New 
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Subdialogs

Translate 
- Name 
- DIL Text 

Assign 

Browsing Through the Applications

 To browse through currently defined applications

1.  Choose the Application icon. 
The Browse Applications dialog appears. 

The Application list box contains all currently defined applications. For each application, the application
ID, name, whether it is a main or sub-application and the Natural library in which the corresponding dialogs
are stowed are displayed. 

 To search for an application

1.  Choose the client from the Client ID drop-down list box. 
2.  In the Application ID text box, enter the application’s full ID or the first couple of characters and choose the

Search button. 
The system scrolls through the Application list box until that application appears at the top. 
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Adding Applications

 To add a new application

1.  Choose the Application icon.
The Browse Applications dialog appears. 

2.  Choose the Create a New Object tool bar button.
The Maintain Application dialog appears.
When you add an application, the following dialogs are used: 

3.  In the Name text box, enter the name of the application.
If translating the name into another language is required, choose the Translate button.
In multi-language applications, care must be taken that all command words are defined in all necessary
languages, since otherwise there is no guarantee that all functions are available in all languages. 

4.  In the DIL text text box, enter the text to be displayed in the Dynamic Information Line when this
application’s icon is selected. 

5.  In the Bitmap text box, enter the name of the icon designated for this application.
Do not include the icon file name extension ".bmp".
You can obtain the name of the icon from the Natural bitmap library set in the NATGUI_BMP parameter.
It is recommended that you use the predefined bitmap ZAPPL. 
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6.  Select either the Main Application or Sub-application option button, depending upon the type of
application. 

7.  (Required only if the application is a main application.) In the Library text box, enter the name of the
Natural library in which this application is cataloged. 

8.  Choose the Assign button. 
As a result, the Assign dialog appears. 

9.  Choose the type of object(s) in the Type drop-down list box that will be available in the graphical
navigation for this application (i.e. the icons that will be displayed when a application is choosen). 

Type Meaning 

Start an application The object type displayed is a sub-application. 

Start a function The object type displayed is a function. 

Start a list The object type is a browse function. 

You can select each type as often as you want. However, to activate a type, you must first complete the next
step before you select another type. 

10.  In the Assign combo box, select the IDs which represent the sub-applications or lists that will be available
with the object type selected in the previous step. In the case of functions, an additional drop-down list box
appears below the Assign combo box. It contains the actions (e.g. display, delete) which can be performed with
the functions. From the Assign combo box, select the action and function. As a result, the selected ID, the type of
object (A - application, O - object type, F - function) and the action (only in case of functions) appear in the list
box. To place a selected item in a particular position in the list box, first choose the position in the list box. From
the Assign combo box, select the item. The new item will be placed above the selected position. If you want to
remove an item, select the item in the list box and choose the Remove button. 

11.  Optional - Repeat the last two steps to define another object type.
You can choose up to 36 assignments for each application. 

12.  Choose the OK button.
The Maintain Application dialog appears. 
A message box appears. Choose the Yes button to save your changes. 
The "Save object as" dialog appears. 
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Modifying, Displaying or Deleting Applications

 To modify or display an application

1.  Choose the Application icon. 
2.  Choose the Modify an Object from the Browse Applications dialog, select the application to be modified.

The Maintain Application dialog appears. If you need to modify the object, choose the Modify an Object
button and make the modifications you want. 

 To delete an application

1.  Choose the Application icon. 
2.  Choose the Delete an Object button from the Browse Applications dialog, select the application to be

modified. 
A message box appears. Choose Yes to confirm, or No to cancel the deletion. 
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Background Procedure
Various functions (e.g. load and unload data) can be implemented as background processes so as not to delay
online processing. 

Besides the standard parameters that can be used with a background process, you can define up to 5 user
parameters which further increases the flexibility of the procedure that is to be processed. 

Function Overview 

Actions

Browse 
Delete 
Display 
Modify 
New 

Subdialogs

Translate 
- Description 

Browsing Through Background Procedures

 To browse through currently defined background procedures

Choose the Background Procedure icon. 
The Browse Background Procedures dialog appears. 

The Procedure list box contains all currently defined procedures. For each procedure, the name and
description of the procedure are displayed. 

 To search for a background procedure

1.  Choose the client from the Client ID drop-down list box,. 
2.  Choose the Search button in the Procedure ID text box, enter the procedures full ID or the first couple of

characters. 
The system scrolls through the Procedure list box until that procedure appears at the top. 
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Adding Background Procedures

 To add a new background procedure

1.  Choose the Background Procedure icon.
The Browse Background Procedures dialog appears. 

2.  Choose the Add a New Object tool bar button. 
The Maintain Background Procedure dialog appears. 

3.  In the Description test box, enter a description of the background procedure.
If translating the description into another language is required, choose the Translate button. 

4.  In the Background procedure text box, enter the application procedure for your system environment. 
This text box also contains standard parameters which can be used when loading or unloading data.
Standard parameters begin with LZ. 
The following standard parameters are provided. 

Standard Parameter Description 

LZ_BG_NAME Name or title of background process 

LZ_LIBRARY Library in which the program will run 

LZ_NATPARM Natural parameter module 

LZ_PROGRAM Program name 

LZ_PRINTER Printer name 

LZ_PRIORITY Priority of process 

LZ_PSW Password 

LZ_SESSION Program name and time stamp 

LZ_USER User ID 

LZ_WORKFILE Work file path and name 

In addition, you can define up to 5 user parameters. They must begin with L_ (e.g. L_COMPANY_NAME).
Before the procedures are run, the user must define how the user parameters will be used. 
A message box appears. 

5.  Choose the Yes button to save your changes. 
The "Save object as" dialog appears. 
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Modifying, Displaying or Deleting Background Procedures

 To modify or display a background procedure

1.  Choose the Background Procedure icon. 
2.  Choose the Modify an Object or Display an Object button from the Browse Background Procedures dialog.

Select the procedure needed. 
The Maintain Background Procedure dialog appears. 
If you have chosen to display the object but want to modify the object, use the Modify an Object button and
make the modifications you want. 
If you have modified the data, a message box appears. Use the Yes button to save your changes. 

 To delete a background procedure

1.  Choose the Background Procedure icon. 
2.  Choose the Delete an Object button from the Browse Background Procedures dialog. Select the procedure 

needed.
A message box appears. 

3.  Select Yes to confirm, or No to cancel the deletion. 
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Background Process
A background process can be used to observe procedures such as loading and unloading data. 

For further information, see the Natural Frame Gallery documentationl. 

Function Overview

Actions

Browse 
Delete 

Subdialogs

Display Error Log 
Modify Error Log 

Browsing Through Background Processes

 To browse through current background processes

Choose the Background Process icon. 
The Browse Background Processes dialog appears. 

The Function list box contains all existing processes. For each process, the function name, the user ID that
started the process, whether or not the process can be restarted in case of an error (restartable indicated with
an X in the "R" column) and the status of the process are displayed. 

 To search for a background process

1.  In the Client ID drop-down list box, select the client. 
2.  In the User ID text box, enter the user’s ID and choose the Search button. 

The system scrolls through the Function list box until the processes for that user appear at the top. 
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Modifying, Displaying or Deleting Background Processes

 To modify or display the error log via a background process

1.  Choose the Background Process icon. 
2.  Choose the Modify an Object or Display an Object button from the Browse Background Processes dialog.

Select the process needed. 
The Maintain Error Log dialog appears. If you have modified the data, a message box appears. Choose the
Yes button to save your changes. 

 To delete a background process

1.  Choose the Background Process icon. 
2.  Choose the Delete an Object button from the Browse Background Processes dialog. Select the process

needed. 
A message box appears. Select Yes to confirm, or No to cancel the deletion. 
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Command
The combination of a command and object type is used to perform a function. The type of command (e.g. action,
submenu, start an application) determines where or how the function is performed. 

Function Overview

Actions

Browse 
Delete 
Display 
Modify 
New 

Subdialogs

Translate 
Name 
- DIL text 

Browsing Through Commands

 To browse through existing commands

Choose the Command icon. 
The Browse Commands dialog appears. 

The Command list box contains all currently defined commands. For each command, the command ID and
command’s full name are displayed. 

 To search for a command

1.  In the Client ID drop-down list box, select the client. 
2.  In the Command ID text box, enter the command’s full ID or the first couple of characters and choose the

Search button. 
The system scrolls through the Command list box until that command appears at the top. 
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Adding Commands

 To add a new command

1.  Choose the Command icon.
As a result, the Browse Commands dialog appears. 

2.  Choose the Create a New Object tool bar button. 
The Maintain Command dialog appears. 

3.  In the Name text box, enter the full name of the command.
If translating the name into another language is required, choose the Translate button.
In multi-language applications, care must be taken that all commands are defined in all necessary
languages, since otherwise there is no guarantee that all functions are available in all languages. 

4.  In the "DIL text" text box, enter the text to be displayed in the Dynamic Information Line when this
command’s button is chosen. 

5.  In the Bitmap text box, enter the name of the icon designated for this command.
You need only to define a bitmap for a command when you also define a tool bar button for the command.
You can obtain the name of the icon from the Natural bitmap library set in the NATGUI_BMP parameter.
Do not include the bitmap file name extension ".bmp". 
An example of the bitmap appears to the right of the Bitmap text box. 
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6.  In the Main Type drop-down list box, select the primary function the command will perform.
You can select one of the following: 

Use Description 

Local function
A local function is started directly from the current dialog. It can be a subdialog or an
internal calculation. 
For example, Translate. If selected, skip Step 6. 

Action
An action is performed, e.g. Add, Modify. 
If selected, skip Step 5. 

Start a browser
A browse is started. 
If selected, skip Step 6. 

Start a function A function is started, e.g. Add customer. 

Start an 
application

An application is started. 
If selected, skip Step 6. 

Submenu
A drop-down menu appears when a menu command is selected. If selected, skip
Steps 5 and 6. 

7.  In the Parameter text box, enter: 
- an object type, if you selected Start a Browser in Step 4, 
- or a function, if you selected Start a Function in Step 4, 
- or an application, if you selected Start an Application in Step 4. 
If you selected Local Function in Step 4, you need not enter a parameter. 
This drop-down list box appears only if you selected Action as the main type in Step 4. 
You can select one of the following: 

Type Description 

Add Add an object. 

Modify Modify an object. 

Display Display an object. 

Delete Delete an object. 

Mass ProcessingPerform mass processing on several objects. 

A message box appears. Choose the Yes button to save your changes. 

Copyright © Software AG 200240

Object MaintenanceAdding Commands



Modifying, Displaying or Deleting Commands

 To modify or display a command

1.  Choose the Command icon. 
2.  Choose the Modify an Object or Display an Object button from the Browse Commands dialog. Select the

command needed.
As a result, the Maintain Command dialog appears.
If you have chosen to display the command but really want to modify it, choose the Modify an Object
button and make the modifications you want. 

3.  Choose the Close button.
If you have modified the data, a message box appears. Choose the Yes button to save your changes. 

 To delete a command

1.  Choose the Command icon. 
2.  Choose the Delete an Object button from the Browse Commands dialog. Select the command needed. 

A message box appears. Select Yes to confirm, or No to cancel the deletion. 
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Dialog Type
When you add a main dialog, you must also assign a tool bar. Tool bars are not defined for subdialogs (e.g. the
Translation dialog). It is recommended that you first add the dialog type without specifying a tool bar, then add
the tool bar and, finally, modify the dialog to define the newly created tool bar. 

Function Overview

Actions

Browse 
Delete 
Display 
Modify 
New 

Subdialogs

None 

Browsing Through Dialog Types

 To browse through existing dialogs

Choose the Dialog Type icon. 
The Browse Dialog Types dialog appears. 

The Dialog Type list box contains all currently defined dialogs. For each dialog, the dialog ID and the
corresponding tool bar ID are displayed. 

 To search for a dialog

1.  In the Client ID drop-down list box, select the client. 
2.  In the Dialog type ID text box, enter the dialog’s full ID or the first couple of characters and choose the

Search button. 
The system scrolls through the Dialog Type list box until that dialog appears at the top. 
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Adding Dialog Types

 To add a new dialog type

1.  Choose the Dialog Type icon.
The Browse Dialog Types dialog appears. 

2.  Choose the Create a New Object tool bar button. 
The Maintain Dialog Type dialog appears. 

3.  In the Tool Bar drop-down list box, select the tool bar that is to be displayed with this dialog type. If you
have not yet defined the tool bar, leave this drop-down list box blank. When you have completed the
remaining steps, define the tool bar and then complete this step. 

4.  Choose the commands from the Available Commands combo box for the dialog type needed. 
The selected commands appear in the Selected Commands list box. 
If you have selected a command you do not want, mark the command in the Selected Commands list box,
and use the Remove button. The command is then removed from the list box. 
A message box appears. 

5.  Choose the Yes button to save your changes. 
The "Save object as" dialog appears. 

Modifying, Displaying or Deleting Dialog Types

 To modify or display a dialog type

1.  Choose the Dialog Type icon. 
2.  Choose the Modify an Object or Display an Object button from the Browse Dialog Types dialog. Select the

dialog type needed. If you have chosen to display the dialog type but really want to modify it, choose the
Modify an Object button and make the modifications you want. 

3.  Choose the Close button. 
If you have modified the dialog type, a message box appears. Choose the Yes button to save your changes. 

 To delete a dialog type

1.  Choose the Dialog Type icon. 
2.  Choose the Delete an Object button from the Browse Dialog Types dialog. Select the dialog type needed. 

A message box appears. Select Yes to confirm, or No to cancel the deletion. 
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Error Log
Errors which occur during a load or unload are stored in the error log. 

Function Overview

Actions

Browse 
Delete 
Display 
Modify 

Browsing Through Error Logs

 To browse through existing error logs

Choose the Error Log icon. 
The Browse Error Logs dialog appears. 

The Date list box contains all error logs that occurred on or after the date specified in the Date text box. For
each error log, the date and time the error occurred, the user ID, and a description of the error are displayed. 

 To search for an error

1.  In the Client ID drop-down list box, select the client. 
2.  In the Date text box, enter the start date and choose the Search button. 

The system scrolls through the Date list box until the errors which occurred on or after the start date appear
at the top. 
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Displaying Error Logs

 To display error logs

1.  Choose the Error Log icon. 
2.  Choose the Display an Object button from the Browse Error Logs dialog. Select the dialog type needed. 

The Maintain Error Log dialog appears. 

Function Name of function that caused the error. 

Program Name of Natural program that generated the error. 

No. Error number. 

System Device type/mode from which Natural has been invoked. 

Library Name of Natural library containing the program in which the error occurred. 

Line Line number in program in which error occurred. 

Main prg. Dialog ID that called the background program. 

Error 
message

Description of error. 

Comments
Description of any prior actions performed that could have caused the error and/or
recommendations to correct the error. 
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Modifying or Deleting Error Logs

 To modify an error log

1.  Choose the Error Log icon. 
2.  Choose the Modify an Object button from the Browse Error Log dialog. Select the dialog type needed. 
3.  In the Comments text box, enter a description of any prior actions performed that could have caused the

error and/or recommendations to correct the error. 
4.  Choose the Close button. 

A message box appears. Choose the Yes button to save your changes. 

 To delete an error log

1.  Choose the Error Log icon. 
2.  From the Browse Error Logs dialog, select the log and choose the Delete an Object button. 

A message box appears. Choose the Yes button to confirm, or No to cancel the deletion. 

Copyright © Software AG 200246

Object MaintenanceModifying or Deleting Error Logs



Function
A function consists of a command and an object type. One or more dialogs and subprograms are responsible for
the execution of the function. Before a function can be executed, the function must first be defined as a
combination of a command and an object type. 

Before you define a function, ensure that the required commands and object type have been defined. 

Function Overview

Actions

Browse 
Delete 
Display 
Modify 
New 

Subdialogs

Translate 

Translate

Function name 
DIL text 

Browsing Through Functions

 To browse through existing functions

1.  Choose the Function icon. 
The Browse Functions dialog appears. 

The Function list box contains all currently defined functions. For each function, the function ID, function
name, the dialog ID or name of the subprogram in which the function is implemented and the set up (e.g.
access security, temporary copy) are displayed. 

 To search for a function

1.  Choose the client from the Client ID drop-down list box. 
2.  Choose the Search button from the Function ID text box, enter the function’s full ID or the first couple of

characters. 
The system scrolls through the Function list box until that function appears at the top. 
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Adding Functions

 To add a function

1.  Choose the Function icon.
The Browse Functions dialog appears. 

2.  Choose the Create a New Object tool bar button. 
The Maintain Function dialog appears. 

3.  In the Name text box, enter the name of the function.
If translating the name into another language is required, choose the Translate button.
In multi-language applications, care must be taken that all functions are defined in all necessary languages
to ensure correct operation. 

4.  In the DIL Text text box, enter the text to be displayed in the Dynamic Information Line when the icon for
this function is chosen. 

5.  In the Obj. type ID text box, enter the ID of the object type,
or if you are unsure of the ID, choose Settings button to the right of this text box.
The object type ID determines the type of object, e.g. Customer, Contract. 
If you selected the Settings button, the Selection dialog appears. 

6.  From the Type drop-down list box, select one of the following: 

Dialog The function will be implemented in a dialog. 

Subprogram The function will be implemented as a subprogram. 
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7.  In the Natural Module text box, enter the name of the dialog ID if you select Dialog or enter the name of the
subprogram if you select Subprogram. 

8.  In the Bitmap text box, enter the name of a previously defined bitmap.It is recommended that you use the
predefined bitmap ZFCT. An example of how the bitmap will be displayed in the application appears to the right
of the text box. 
In the following step, you must define the commands that can be performed with this function. You can
define up to three commands. The commands are then linked to the object type. The combination of a command
and the object type must be unique, i.e. the combination cannot be used with another function. 

9.  In the Command text boxes, choose the Settings button.
The selection dialog appears. 

10.  From the Maintain Function dialog, you can select one or more items in the Setup group box: 

Access security Function will only be available to users with authorization. 

Temporary 
copy

Any modifications made with this function will be maintained in a preliminary file
instead of in an internal buffer until the modifications are saved. 

Activation via 
RPC

Remote procedure call with a LAN or WAN. 

11.  Choose the Close button. 
A message box appears. Choose the Yes button to save your changes, No to quit without saving your
changes, or Cancel to return to the Maintain Function dialog. 
If you chose the Yes button, the "Save object as" dialog appears. 

Modifying, Displaying or Deleting Functions

 To modify or display a function

1.  Choose the Function icon. 
2.  Choose the Modify an Object or Display an Object button from the Browse Functions dialog. Select the

function needed. 
The Maintain Function dialog appears. If you have chosen to display the function but really want to modify
it, choose the Modify an Object button and make the modifications you want. 

3.  Choose the Close button. 
If you have modified the function, a message box appears. Choose the Yes button to save your changes. 

 To delete a function

1.  Choose the Function icon. 
2.  From the Browse Functions dialog, select the function and choose the Delete an Object button. 

A message box appears. Choose Yes to confirm, or No to cancel the deletion. 
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Function Group
To define the functional access security, sets of functions are collected into function groups that can then in turn
be linked to users. A function group must be defined before one or more functions can be linked to it. 

Function Overview

Actions

Browse 
Delete 
Display 
Modify 
New 

Subdialogs

Allow Functions 
Disallow Functions 
Translate 
Affected text box: 
- Function group name 

Browsing Through Function Groups

 To browse through existing function groups

Choose the Function Group icon.
The Browse Function Groups dialog appears. 

The Function group ID list box contains all currently defined function groups. For each function group, the
function-group ID and name are displayed. 

 To search for a function group

1.  In the Client ID drop-down list box, select the client. 
2.  In the Function Group ID text box, enter the function group’s ID or the first couple of characters and choose

the Search button. 
The system scrolls through the Function group list box until that function group appears at the top. 
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Adding a Function Group

 To add a new function group

1.  Choose the Function Group icon.
The Browse Function Groups dialog appears. 

2.  Choose the Create a New Object tool bar button. 
The Maintain Function Group dialog appears. 

3.  In the Name text box, enter the name of the function group.
If translating the name into another language is required, choose the Translate button.
In multi-language applications, care must be taken that all function groups are defined in all necessary
languages to ensure correct operation. 

4.  Choose the Allow button. 
The Allow Functions dialog appears. From this dialog, you can select the functions that are to be a part of
this function group. 

5.  In the Available Functions combo box, select the function you want to include in the function group and
choose the Select button.
The function you selected appears in the Allowed functions list box.
If you choose a function you do not want, choose the function from the Allowed functions list box and use
the Remove button. The function is then removed from the list box. 
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6.  Choose the OK button. 
As a result, the functions are displayed in the Allowed functions list box in the Maintain Function Group
dialog. 
The Disallow Functions dialog appears. From this dialog you can select the functions that cannot be used
with this function group. 

7.  In the Available Functions combo box, select the functions you want to disallow and choose the Select 
button.
As a result, the functions you selected appear in the Disallowed functions list box.
If you select a function you do not want to disallow, select the function from the Disallowed functions list
box, and choose the Disallow button. The function is then removed from the list box. 

8.  Choose the OK button. 
The functions are displayed in the Disallowed Functions list box in the Maintain Function Group dialog. 

Modifying, Displaying or Deleting a Function Group

 To modify or display a function group

1.  Choose the Function Group icon. 
2.  Choose the Modify an Object or Display an Object button from the Browse Function Groups dialog, select

the function group needed. 
The Maintain Function Group dialog appears. 
If you have chosen to display the function group but really wanted to modify it, choose the Modify an
Object button and make the modifications you want. 
If you have modified the function group, a message box appears. Choose the Yes button to save your
changes. 

 To delete a function group

1.  Choose the Function Group icon. 
2.  Choose the Delete an Object button from the Browse Function Groups dialog, select the function group

needed. 
A message box appears. Select Yes to confirm, or No to cancel the deletion. 
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Initialized Data
Initialized data is created whenever the application-shell is started. The object types, functions, commands, etc.
you are permitted to access are recorded in the data buffer during the initialization. Each time an object type and
action is performed, it is also recorded in the data buffer. Thus if a problem occurs, you can use the initialized
data to quickly determine the error. 

Note: 
You cannot access initialized data for other administrators or developers.

Function Overview

Actions

Display 
Refresh 

Subdialogs

None 

Displaying Initialized Data Information

 To display existing initialized data information

1.  From the Options menu, choose the Display initialized data icon.
The Data Buffer Information dialog appears. 

The Initialized Data Information dialog displays the events that have occurred from your PC since the
application-shell was initialized and the number of object types, functions, commands, etc. that are
accessible to you in the data buffer. With each event you perform, the data buffer is updated. The next time
you display this dialog, it is also updated. 

53Copyright © Software AG 2002

Initialized DataObject Maintenance



2.  Optional - Select an option button and choose the Display Buffer button.
A report appears listing the available objects in the data buffer. 

3.  Choose the Close button to return to the Initialized Data dialog. 
4.  Optional - Choose the Reset Statistic button to refresh the dialog. 
5.  Optional - Choose the Stop Statistic button to stop updating the data buffer. 
6.  Optional - Choose the Clear Buffer button to clear the data buffer before the next initialization. 

 To refresh initialized data information

Choose the Refresh initialized data icon from the Options menu. 
The application-shell is re-initialized and the data buffer is refreshed. 
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Languages
An application can be used in a maximum of 9 languages. The application-shell is delivered with 9 predefined
languages. However, error messages and dialogs are initially only available in English and German. The
Language icon contains information on all languages available within the application. 

To use an application in a language other than English or German, error messages and dialogs must be translated.
For further information, see the Natural Frame Gallery documentation. Next, the data contents in the dialogs
must be translated. 

Function Overview

Actions

Browse 
Delete 
Display 
Modify 
New 

Subdialogs

Translate 
Affected text boxes: 
- Name 
- DIL text 

Browsing Through Languages

 To browse through currently defined languages

Choose the Language icon. 
The Browse Languages dialog appears. 

The Language list box contains all currently defined languages. For each language defined, the internal
application-shell number, the Natural language code and the name of the language are displayed. 

 To search for a language

In the Language ID text box, enter the language’s internal application-shell number for that language and
choose the Search button. 
The system scrolls through the Language list box until that language appears at the top. 
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Adding a Language

 To add a new language

1.  Choose the Language icon.
The Browse Languages dialog appears. 

2.  Choose the Create a New Object tool bar button. 
The Maintain Language dialog appears. 

3.  In the Name text box, enter the name of the new language.
If translating the name into another language is required, choose the Translate button. 

4.  In the Natural code text box, enter the Natural code number for that language. 
As a result, a message box appears. 

5.  Choose the Yes button to save your changes. 
The "Save object as" dialog appears. 

Modifying, Displaying or Deleting a Language

 To modify or display a language

1.  Choose the Language icon. 
2.  From the Browse Languages dialog, select the language and choose the Modify an Object, or Display an

Object button. 
The Maintain Language dialog appears. 
If you have chosen to display the object but want to modify the object, choose the Modify an Object button
and make the modifications you want. 
If you have modified the data, a message box appears. Choose the Yes button to save your changes, No to
quit without saving your changes, or Cancel to return to the Maintain Language dialog. 

 To delete a language

1.  Choose the Language icon. 
2.  From the Browse Languages dialog, select the language and choose the Delete an Object button. 

A message box appears. Select Yes to confirm, or No to cancel the deletion. 
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Load Log
The load log contains entries for each unload and load transaction. Log data can be displayed but not modified. 

Function Overview

Actions

Browse 
Delete 
Display 

Subdialogs

Statistics 

Browsing Through Load Logs

 To browse through current load logs

Choose the Load Log icon. 
The Browse Load Logs dialog appears. 

The Date list box contains all load logs which occurred on and after the date in the Date text box. For each
load log, the date and time the load occurred, the User who performed the load, object type processed,
whether the data was unloaded or loaded, whether an error occurred and any warnings issued are displayed.
If an error occurs during a load or unload, it is logged in the error log. 

 To search for log

1.  In the Client ID drop-down list box, select the client. 
2.  In the Date text box, enter the start date and choose the Search button. 

The system scrolls through the Date list box until the logs which occurred on or after the start date appear at
the top. 

Displaying a Load Log

 To display a load log

1.  From the Browse Load Log dialog, select the log and choose the Display an Object button. 
The Display Load Log dialog appears. 
Note: 
The dialog displayed below pertains to an unload procedure. It is similar to what appears with a
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load-procedure log.

User Name and ID of the user who initiated the load or unload procedure. 

Object type Object type loaded or unloaded. 

Procedure
Background procedure used to load or unload the objects. This is defined in the 
Background Processing dialog. 

Program
Program used to perform the background procedure. This is defined in the 
Background Processing dialog. 

Start key
A start value which, with the end key value, determines the objects that are
unloaded. For example, if the start key is CA and the end key is M, only objects
from CA through M are loaded or unloaded. 

End key
An end value which, with the start key value, determines the objects that are
loaded or unloaded. 

Additional parameter 
Additional criteria that is used to determine the objects that are loaded or
unloaded. 

Work file PC work file from which the objects are loaded or unloaded. 

Delete objects at end 
Unload procedure only. Marked if the objects were deleted from the system at
the end of the unload procedure. 

Dependent objects
loaded/unloaded 

Marked if objects that are linked (dependent) to the object type are also
unloaded. 
For example, the dependent objects for object type Function Group include
users and functions. 

Level unloaded
Unload procedure only. Used in conjunction with the "Unload dependent
objects" check box. Determines the level in the hierarchy of the dependent
objects that are unloaded. 

Overwritten
Load procedure only. Marked if previous objects in the system were overwritten
with new data. 
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2.  Choose the Statistics button. 
The Statistical Information dialog appears. 

The "Number of main objects" column pertains to the object types loaded or unloaded, as specified in the
Object Type text box in the Display Load Log dialog. 
The "Number of sub-objects" column pertains to dependent objects loaded or unloaded. 
The Total column displays the total number of objects and dependents. 

Successful Number of objects and dependents unloaded successfully. 

Errors
Number of objects and dependents with which errors occurred. If an error occurs during the
unload procedure, an error log is created. 

Warnings Number of warnings that occurred. 

Overwritten Load procedure only. Number of objects and dependents overwritten. 

Skipped Load procedure only. Number of objects and dependents not loaded. 

Deleted
Unload procedure only. Number of objects and dependents deleted after the unload
procedure. In this case, the "Delete objects at end" check box in the "Display Load Log"
dialog is marked. 
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Locks
A lock entry is used to store references to object keys that are currently being accessed by other users. 

If a reference to an object key exists, no one else can access it. Thereby the object is logically locked. 

Function Overview

Actions

Browse 
Delete 

Subdialogs

None 

Browsing Through Locked Logs

 To browse through current locks

Choose the Lock icon. 
The Browse Lock Entries dialog appears. 

The Object type list box contains either all object types or a specific object type that are currently in use.
For each locked entry, the object type, function ID, user and, date and time the entry was locked are
displayed. 

 To search for a locked entry

In the Object type drop-down list box, select the object type and choose the Search button. 
If that object type is currently in use, it is displayed in the Object type list box. 
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Object Type
The execution of a function consists of the designation of an object type in combination with a command. The
object type determines on which data the specified command is to be executed. 

Since the user interface can exist in several languages, the individual function components must also be
convertible into several languages. 

When integrating new functions into the application, you must ensure that the required objects exist. An object
type must be added before it can be used in combination with a function. 

Function Overview

Actions

Browse 
Delete 
Display 
Load 
Modify 
New 
Unload 

Subdialogs

Translate 
Affected text boxes: 
- Object name 
- DIL text 

Procedure 

Browsing Through Object Types

 To browse through existing object types

Choose the Object Type icon. 

The Object type list box contains all currently defined object types. For each object type, the object type ID,
the name of the object type and the browse dialog ID are displayed. 

 To search for an object type
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1.  In the Client ID drop-down list box, select the client. 
2.  In the Object type ID text box, enter the object type’s full ID or the first couple of characters and choose the

Search button. 
The system scrolls through the Object type list box until that object type appears at the top. 

Adding an Object Type

 To add a new object type

1.  Choose the Object Type icon.
The Browse Object Types dialog appears. 

2.  Choose the Create a New Object tool bar button. 
The Maintain Object Type dialog appears. 

3.  In the Name text box, enter the name of the object.
When choosing an object name, care should be taken that the object is easy for the end user to recognize.
If translating the name into another language is required, choose the Translate button. 

4.  In the DIL Text text box, enter the text to be displayed in the Dynamic Information Line when this object is
chosen. 

5.  In the Bitmap text box, enter the name of the icon designated for this object type.
It is recommended that you use the predefined bitmap ZOBJTYP.
You can obtain the name of the bitmap from the Natural bitmap library set in the NATGUI_BMP 
parameter.
Do not include the bitmap file name extension ".bmp". 

6.  Optional - In the Dialog ID text box, enter the ID of the browse dialog for this object. 
7.  Optional - If you want load and unload data procedures for this object type, choose the Procedure button. 

The Background Processing dialog appears. 

8.  In the Natural Library text box, enter the name of the library in which the unload or load program is located. 
9.  In the Load or Unload group box, select a background procedure from the Background Procedure

drop-down list box.
This is a previously defined name for the background procedure. 

10.  In the Load or Unload group box, select a background program from the Program drop-down list box.
This is the name of the background program used to perform the background procedure. For further
information, see the Natural Frame Gallery documentation. 

11.  Choose the OK button. 
The Maintain Object Type dialog appears. 
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A message box appears. 
12.  Choose the Yes button to save your changes. 

If you chose the Yes button, the "Save object as" dialog appears. 

Modifying, Displaying or Deleting an Object Type

 To modify or display an object type

1.  Choose the icon. 
2.  From the Browse Object Types dialog, select the object and choose the Modify an Object, or Display an

Object button. 
The Maintain Object Type dialog appears. 
If you have chosen to display the object but really want to modify it, choose the Modify an Object button
and make the modifications you want. 
If you have modified the object, a message box appears. Choose the Yes button to save your changes. 

 To delete an object type

1.  Choose the icon. 
2.  From the Browse Object Types dialog, select the object and choose the Delete an Object button. 

As a result, a message box appears. Select Yes to confirm, or No to cancel the deletion. 
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Unloading Data

Note: 
Do not unload data while users are on the system, as errors will occur.

 To unload data

1.  Choose the Direct Call button.
The Direct Call dialog appears. 

2.  Select object type and the action Unload, and choose the Start button. 
The Unload Data dialog appears. 

3.  In the Object type drop-down list box, select the object type to be unloaded.
The Control Data group box is automatically filled, depending upon the object type selected. The
information displayed here is taken from the Background Processing dialog for that object type. 

4.  Optional - In the Start key text box, enter a start value, e.g. CA .
The start key, together with the end key, determines the objects that are unloaded. For example, if the start
key is CA and the end key is M, only objects from CA through M are unloaded. 

5.  Optional - In the End Key text box, enter an end value. 
6.  In the "Unload in work file" text box, enter the PC path and file in which the data is to be unloaded. 
7.  Optional - In the Additional criteria text box, enter additional criteria required to unload the objects.

This step is relevant only in the case of specialized object types. 
8.  Optional - From the Setup group box, select the Delete objects at end check box to delete all objects when

the procedure successfully ends. 
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9.  Optional - From the Setup group box, select the "Unload dependent objects" check box to unload objects
that are linked to the selected object type and in the Unload down to text box, enter to which level (1 through 9)
in the hierarchy of the dependent objects should be unloaded.
The following dependent levels are available: 

  Dependents   

Object Type 1st Level 2nd Level 3rd Level 

Application 
Function
Object type
Application 

Command
Object type 

  

Dialog Type 
Command
Tool bar 

   

Function 
Command
Object type 

   

Function Group Function 
Command
Object type 

  

Tool Bar 
Command
Dialog type 

   

User Function group Function 
Command
Object type 

For example, the dependent objects for object type Function Group includes function, command and object
type. If you enter 2 in the Unload down to text box, all three dependents will be unloaded. 
If user parameters are available for the object type, the Parameter button is enabled. 

10.  Choose the Parameter button and define the values for the user parameters in the resulting dialog. 
All user parameters must be defined. 

11.  Choose the Unload button. 
When the unload procedure ends successfully, a report of the objects unloaded appears. You press ENTER
to page through the report. 
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Loading Data

Note: 
Do not load data while users are on the system, as errors will occur.

 To load data

1.  Choose the Direct Call tool bar button.
The Direct Call dialog appears. 

2.  Select object type and the action Load, and choose the Start button. 
The Load Data dialog appears. 

3.  In the Object Type drop down list box, select the object type to be loaded.
The Control Data group box is automatically filled, depending upon the object type selected. The
information displayed here is taken from the Background Processing dialog for that object type. 

4.  Optional - In the Start Key text box, enter a start value, e.g. CA.
The start key, together with the end key, determines the objects that are loaded. For example, if the start key
is CA and the end key is M, only objects from CA through M are loaded. 

5.  Optional - In the End Key text box, enter an end value. 
6.  In the "Load from work file" text box, enter the PC file from which the data is to be loaded. 
7.  Optional - In the Additional Criteria text box, enter additional criteria required to load the objects.

This step is relevant only in the case of specialized object types. 
8.  Optional - From the Setup group box, select the "Load dependent objects" check box to load objects that are

linked to the selected object type.
For example, the dependent objects for object type Function Group include users and functions. 

9.  Optional - From the Setup group box, select the Overwrite existing objects check box to overwrite objects
currently in the system with new data.
If user parameters are available for the object type, the Parameter button is enabled. 

10.  Choose the Parameter button and define the values for the user parameters in the resulting dialog. 
All user parameters must be defined. 

11.  Choose the Load button.
When the load procedure ends successfully, a repor----- t of the objects loaded appears. You press ENTER
to page through the report. 
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Preliminary File
When modifications are made to an object type or object, the modifications are stored in either a preliminary file
or in an internal buffer. They are stored in a preliminary file when the Preliminary file option button in the
Maintain Function dialog is marked. If this option button is not marked, then the modifications are stored in an
internal buffer. Thus the original files are left intact until the modifications are confirmed. 

After the modifications are completed, the original files are updated with the contents of the preliminary file,
which are then deleted. 

Function Overview

Actions

Browse 
Delete 

Sub-dialogs

None 

Browsing Through Preliminary Files

 To browse through preliminary files

Choose the Preliminary icon. 
The Browse Preliminary Files dialog appears. 

The Date list box contains all preliminary files. For each file, the date and time the file was created, the user
who created the file, object type, function ID, and if the file is marked for deletion are displayed. 

 To search for a preliminary file

1.  In the Client ID drop-down list box, enter the client ID. 
2.  In the Date text box, enter the start date. 
3.  In the User text box, enter the user’s ID that created the preliminary file. 
4.  Choose the Search button. 

The preliminary files created by the user on or after the specified date are displayed in the Date list box. 
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Table
Using the table maintenance system integrated in the application-shell, you can define user-specific tables and
then immediately begin to maintain the table data without additional effort. 

The table definition supports the definition of simple tables with a maximum of fifty fields and four descriptors
that can be freely defined within certain limits. 

If the definitions in the field definition are not sufficient, additional validations can be forced with a user
program. You can even transform field formats (e.g., field with A10 format into N 7.2 format) using a user
program, since the user program is activated in the maintenance of the table content, not in the table definition.
The object type Tables contains the data for table definition but not the table data itself. 

The names of the table fields are language-dependent, i.e. corresponding field names are available for table
maintenance after you have selected the user language. 

Function Overview

Actions

Browse 
Delete 
Display 
Modify 
New 

Subdialogs

New Descriptor 
Parameter 
Translate 
Affected text boxes: 
- Table name 
- Field name 

Copyright © Software AG 200268

Object MaintenanceTable



Browsing Through Tables

 To browse through the existing tables

1.  Choose the Table icon. 
The Browse Tables dialog appears. 

The Table ID list box contains all currently defined tables. For each table, the table ID, name and
description are displayed. 

 To search for a table

1.  In the Client ID drop-down list box, select the client. 
2.  In the Table ID text box, enter the table’s ID and choose the Search button. 

The system scrolls through the Table ID list box until the table appears at the top. 
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Adding a Table

 To add a new table

1.  Choose the Table icon. 
The Browse Tables dialog appears. 

1.  Choose the Create a New Object tool bar button. 
The Maintain Table dialog appears. 

2.  In the Table Name text box, enter the name of the table. 
3.  Choose the New Field button.

The default values are displayed in the Define Field group box.
Define the following in the Define Field group box. 

4.  In the Field Name text box, enter the name of the table field. This field is mandatory.
If translating the table and field names into another language is required, choose the Translate button.
In multi-language applications, care must be taken that all table and field names are defined in all necessary
languages, since otherwise there is no guarantee that all functions are available in all languages. 

5.  In the Format list box, select either A (alphanumeric) or N (numeric). 
6.  In the Length list box, enter the length of the field. This field is mandatory. 

The maximum length for an alphanumeric field is 240 and 27 for a numeric field.
If the Key check box is selected, then the maximum length for an alphanumeric field is 30. 

7.  Select the Key check box, if the field is a descriptor.
At least one field per table must be defined as a key. You can also define a key when you choose the New
Key button. 

8.  Select the Mandatory check box if this table field is required. 
9.  Select the Multilingual check box if the field data is available in other languages. 

10.  Select the Full check box if the field must completely filled. 
11.  Select the Upper case check box if all alphanumeric characters are to be converted to upper case. 
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12.  Select the Leading Zeros check box if numeric key values are to be filled automatically with leading zeros.
For example, if you enter the number 534 in a numeric field with the length of 5, the number is converted to 
00534.
Optional - The following two text boxes are used to define a connection to another table with which data
can be validated. For example, table Customer contains the fields First Name, Last Name, Street and City.
Table Zip Code contains the fields Zip Code and City, and the key Zip Code. If you define Zip Code as the
connecting table (i.e. reference table) and Zip Code as the reference key, each time a zip code is entered in the 
Customer table it is verified against the data in the Zip Code table. 

13.  In the Reference Table text box, enter the name of the connecting table,
or select the Settings button to obtain a list of currently defined tables and select the table from the list. 

14.  In the Reference Key list box, enter a key from the table (specified in the previous step) which will be used
to validate the data.
You can define up to four non-multilingual keys. They are used for individual access to the table data. At
least one key must be defined per table. 

15.  Choose the Accept Field button.
The field name appears in the Fields list box and, if marked as a key, it also appears in the Keys list box.
To delete a previously defined field, choose the Remove button. 

16.  Choose the New Key button. 
The Key Definition dialog appears. 

17.  In the Key text box, enter the name of the key.
If translating the key into another language is required, choose the Translate button.
In multi-language applications, care must be taken that all keys are defined in all necessary languages.to
ensure correct operation. 

18.  Select the Unique check box if you want to validate that the input value for the key is unique. 
19.  In the Field Sequence text box, enter a field name from this table.

You can define up to 5 field names. The values of the fields are then used as the contents of the key. 
20.  In the "From pos. to pos." text boxes, enter which bytes of the field are required for the key. 

For example, the field Last Name is 30 bytes and if you enter 1 and 8 in the From pos. to pos. text box, the
key will contain only the first 8 bytes of each last name. 
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21.  Choose the OK button. 
The Parameter dialog appears. 

22.  Optional - In the Comments list box, enter information concerning the code file.
In the Exits group box, you can define up to two user exits which can be written to perform special
functions. 

23.  Optional - In the Single record text box, enter the user exit name which pertains to a specific field. 
24.  Optional - In the Multiple record text box, enter the user exit name which pertains to all fields defined to

this code file. 
25.  In the Field Delimiter text box, enter a character to be used to separate the field data in the database.

For example, if the character # is used, the field data would be stored as such: First Name#Last
Name#Street#Zip Code#City. 
It is highly recommended that you use a character that will not be used in the field data. As a default, the #
symbol is used. 

26.  Optional - Choose the Translate button.
The Translate - Maintain Code File dialog appears. 

27.  Choose the OK button. 
A message box appears. 

28.  Choose the Yes button to save the addition. 
The "Save object as" dialog appears. 
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Modifying, Displaying or Deleting a Table

 To modify or display a table

1.  Choose the Table Maintenance icon. 
2.  From the Browse Tables dialog, select the table and choose the Modify an Object, or Display an Object

button. 
The Maintain Table dialog appears. 
If you have chosen to display the object but want to modify the object, choose the Modify an Object button
and make the modifications you want. 
If you have modified the data, a message box appears. Choose the Yes button to save your changes. 

 To delete a table

1.  Choose the Table Maintenance icon. 
2.  From the Browse Tables dialog, select the table and choose the Delete an Object button. 

A message box appears. Select Yes to confirm, or No to cancel the deletion. 
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Tool Bar
As a standard, a tool bar is defined for each type of main dialog. Tool bars are not defined for subdialogs. It is
recommended that you first add the dialog type without specifying a tool bar, then add the tool bar and, finally,
modify the dialog to define the newly created tool bar. 

Function Overview

Actions

Browse 
Delete 
Display 
Modify 
New 

Subdialogs

None 

Browsing Through Tool Bars

 To browse through existing tool bars

Choose the Tool Bar icon. 
The Browse Tool Bars dialog appears. 

The Tool bar list box contains all currently defined tool bars. For each tool bar, the tool bar ID and the
corresponding dialog ID are displayed. 

 To search for a tool bar

1.  In the Client ID drop-down list box, select the client. 
2.  In the Tool bar ID text box, enter the tool bar’s full ID or the first couple of characters and choose the

Search button. 
The system scrolls through the Tool bar list box until that tool bar appears at the top. 

Adding a Tool Bar

 To add a new tool bar
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1.  Choose the Tool Bar icon.
The Browse Tool Bars dialog appears. 

2.  Choose the Create a New Object tool bar button. 
The Maintain Tool Bar dialog appears. 

3.  In the Dialog type drop-down list box, select the dialog type with which this tool bar will be used. 
4.  From the Available commands combo box, select the commands which will be available in the tool bar and

choose the Select button.
The commands you select appear in the Selected Command list box.
If you select a command you do not want, select the command from the Selected commands list box, and
choose the Remove button. The command is then removed from the list box. 

5.  Optional - Select a command from the Selected Commands list box and choose the Separator button. 
As a result, a line appears above the selected command and when the tool bar is displayed, the button for
this command is displayed separately from the other buttons (i.e. it is not displayed directly next to another
button). 
As a result, the "Save object as" dialog appears. 

Modifying, Displaying or Deleting a Tool Bar

 To modify or display a tool bar

1.  Choose the Tool Bar icon. 
2.  From the Browse Tool Bars dialog, select the tool bar and choose the Modify an Object, or Display an

Object button. 
As a result, the Maintain Tool Bar dialog appears. 
If you have chosen to display the tool bar but really want to modify it, choose the Modify an Object button
and make the modifications you want. 
If you have modified the tool bar, a message box appears. Choose the Yes button to save your changes, No
to quit without saving your changes, or Cancel to return to the Maintain Tool Bar dialog. 

 To delete a tool bar

1.  Choose the Tool Bar icon. 
2.  From the Browse Tool Bars dialog, select the tool bar and choose the Delete an Object button. 

As a result, a message box appears. Select Yes to confirm, or No to cancel the deletion. 
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User
If access security is implemented, you must define the users in the system so that they can work in the
application. This requires that the user ID must be entered in the object User. 

When a user is defined in this way, the user has access to all functions that are not subject to access security. 

Function Overview

Actions

Browse 
Delete 
Display 
Modify 
New 

Subdialogs

None 

Browsing Through a List of Users

 To browse for a user

Choose the User icon. 
The Browse Users dialog appears. 

The User list box contains all currently defined users. For each user, the user ID, full name and whether the
user has access security are displayed. 

 To search for a user

1.  In the Client ID drop-down list box, select the client. 
2.  In the User ID text box, enter the user’s full ID or the first couple of characters and choose the Search

button. 
The system scrolls through the User list box until that user appears at the top. 
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Adding a User

 To add a user

1.  Choose the User icon.
The Browse Users dialog appears. 

2.  Choose the Create a New Object tool bar button. 
The Maintain User dialog appears. 

3.  In the Name text box, enter the user’s full name.
Authorization is checked through the user ID under which the user is added to the system. The user’s name
is purely for information. 

4.  Select the Access protection check box if you want the user to only access the functions in the selected
function groups.
If you do not select this check box, the user can access all functions (with and without access protection).
If your application does not have access security, this check box is ignored. 

5.  From the Available function groups list box, select the ID for the function group you want to allow the user
to access and choose the Select button. 
The function group ID is displayed in the Selected function group list box. 

6.  If you want to revoke access to a function group, select the function group ID from the Selected function
group list box and choose the Remove button. 
A message box appears. 

7.  Choose the Yes button to save your changes. 
The "Save object as" dialog appears. 
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Modifying, Displaying or Deleting a User

 To modify or display a user

1.  Choose the User icon. 
2.  From the Browse Users dialog, select the user and choose the Modify an Object, or Display an Object

button. 
The Maintain User dialog appears. 
If you have chosen to display the object but want to modify the object, choose the Modify an Object button
and make the modifications you want.
If you have modified the data, a message box appears. Choose the Yes button to save your changes. 

 To delete a user

1.  Choose the User icon. 
2.  From the Browse Users dialog, select the user and choose the Delete an Object button. 

A message box appears. 
3.  Select Yes to confirm, or No to cancel the deletion. 
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The Translation Subdialog
This section describes the translation subdialog that is used in several objects. 

The application shell enables the creation of multilingual applications in which up to nine languages are
supported. Not only can the dialogs and error messages be translated, but also the entire command syntax. In
addition, text boxes (e.g., Name and DIL text) can be translated. 

Using the Translate subdialog, you can only translate into a language which is not currently active. 

 To translate text into another language

1.  Choose the Translate button. 
The Translate dialog appears. The top group box contains the Name/DIL text for the source language. In the
lower group box you translate the Name/DIL text into the target language. 

2.  Select the option button applicable to the target language. 
3.  In the Name text box, enter the translation for the Name text box. 
4.  In the "DIL text" text box, enter the translation for the "DIL text" text box. 
5.  Choose the OK button. 
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